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Xerox WorkCentre 4250/4260 Series
 Priročnik za hitri začetek uporabe

Hvala, ker ste izbrali tiskalnik WorkCentre 4250/4260 Series. Priporočamo, 
da upoštevate vse postopke, opisane v tej knjigi, da si zagotovite uspešno:

priključitev tiskalnika WorkCentre 4250/4260 Series v omrežje,

nastavitev tiskalnika WorkCentre 4250/4260 Series,

namestitev dodatnih funkcij,

uporabo tiskalnika WorkCentre 4250/4260 Series.
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Za varnostne in upravne informacije ter informacije o skladnosti z okoljskimi predpisi, nezakonitih 
kopijah in recikliranju in odmetavanju izdelka glejte ustrezne razdelke v uporabniškem priročniku.

Podrobnejše informacije o funkcijah naprave najdete v uporabniškem priročniku in na CD-ju za skrbnike 
sistema.
Podpora izdelka in informacije o naročanju potrošnega materiala in tiskalnih medijev najdete na 
Xeroxovem spletnem mestu na naslovu www.xerox.com/support.

Pripravil in prevedel:

Xerox
GKLS European Operations
Bessemer Road
Welwyn Garden City
Hertfordshire
AL7 1BU
ANGLIJA

© 2008 Xerox Corporation. 

Xerox® in logotip s kroglo povezljivosti sta blagovni znamki podjetja Xerox Corporation v ZDA in/ali 
drugih državah.
Informacije v tem dokumentu so pravilne v času objave. Xerox si pridržuje pravico kadar koli brez 
obvestila spremeniti te informacije. Spremembe in tehnične posodobitve bodo dodane v prihodnjih 
izdajah dokumentacije.
Najnovejše informacije najdete na spletnem mestu www.xerox.com/support.
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Namestite tiskalnik 
WorkCentre 4250/4260 Series 
1 Odpakirajte napravo in morebitno dodatno strojno opremo.
2 Poiščite navodila za namestitev. 
3 Upoštevajte postopek, opisan v navodilih za namestitev, da sestavite napravo 

in morebitno dodatno opremo. Ko končate, boste imeli eno od teh konfiguracij.

OPOMBA: Vrsta stojala, ki je na voljo, je odvisna od konfiguracije.

Funkcije WorkCentre 
4250

WorkCentre 
4250S/
4260S

WorkCentre 
4250X/
4260X

WorkCentre 
4250XF/
4260XF

Digitalno kopiranje standardno standardno standardno standardno

Neposredno/omrežno 
tiskanje

– standardno standardno standardno

Optično branje – standardno standardno standardno

E-pošta – standardno standardno standardno

Faks dodatno dodatno standardno standardno

Pladenj za papir 1 
in obvod

standardno standardno standardno standardno

Pladenj za papir 2 dodatno dodatno dodatno standardno

Podajalnik za večje 
količine papirja

dodatno dodatno dodatno dodatno/
standardno

Stojalo 
*(glejte opombo)

dodatno dodatno dodatno standardno/
ni potrebno

Dokončevalna enota dodatno dodatno dodatno standardno

Pogon USB standardno standardno standardno standardno

80-GB trdi disk standardno standardno standardno standardno

Vmesnik FDI dodatno dodatno dodatno dodatno

Sistemski pomnilnik 
(256 MB)

standardno standardno standardno standardno

Dodaten pomnilnik 
(256 MB)

dodatno dodatno dodatno dodatno
priročnik za hitri začetek uporabe 3



4 Poleg tega boste imeli:
• napajalni kabel,
• CD z uporabniško dokumentacijo,
• CD za skrbnike sistema,
• CD s tiskalniškimi gonilniki 

(ni priložen napravi WorkCentre 4250, ki je samo za kopiranje),
• CD Nuance (ni priložen napravi WorkCentre 4250, ki je samo za kopiranje),
• priročnik za hitri začetek uporabe (ta knjiga),
• kartuša s črnilom
• nalepke za nadzorno ploščo,
• ključ za omogočanje izdelka, 
• telefonski kabel 

(samo model WorkCentre 4250/4260 Series X in XF s faksom).
4 priročnik za hitri začetek uporabe
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Vklopite napravo
Ko je naprava sestavljena, jo je treba nastaviti. To naredite s ključem za omogočanje 
izdelka, ko je naprava prvič vklopljena.

Ključ za omogočanje izdelka ste 
dobili v prozorni plastični cevki, 
ki je v škatli skupaj z napravo. 
Postopek za nastavitev naprave:

1 Poiščite cevko s ključem za 
omogočanje izdelka. Odstranite 
plastično kartico in ključ previdno 
potisnite ven.

2 Priključite napajalni kabel na 
napravo in primerno zidno vtičnico.

3 Vklopite napravo.
4 Namestite ključ za omogočanje izdelka v režo bralnika kartic na hrbtni strani naprave.

5 Prikazan bo zaslon Language Default. Izberite želeni jezik in nato Save.
6 Prikazan bo zaslon Installation Wizard. Izberite Next.
7 Prikazan bo zaslon Product Enablement Settings. Upoštevajte navodila na zaslonu.

OPOMBA: Ko zelena lučka preneha utripati in neprekinjeno sveti 
(čez približno 10 sekund), je nastavitev uspešno končana. 

8 Odstranite ključ za omogočanje izdelka in na zaslonu izberite možnost Next.
9 Prikazan je zaslon Default Paper Size. Izberite velikost A4 ali 8,5 × 11 palcev in 

nato Next.

ključ za omogočanje izdelka

reža bralnika kartic

zelena lučka
priročnik za hitri začetek uporabe 5



10 Prikazan je zaslon Customer Support and Supplies Numbers. Vnesite telefonsko 
številko podpore za stranke in telefonsko številko za potrošni material ter 
izberite Next.

OPOMBA: Ti številka sta zgolj za vašo informacijo. Če jih nimate, lahko ti polji 
pustite prazni. 

11 V naslednjih štirih zaslonih boste nastavili obliko datuma, datum, obliko ure in 
uro. Upoštevajte navodila, da na vsakem zaslonu vnesete ustrezne podatke, in 
izberite Next.

12 Prikazan bo zaslon Congratulations. To označuje, da ste uspešno končali razdelek 
za sistemske nastavitve v Xeroxovem nastavitvenem čarovniku. Za nadaljevanje 
izberite Finish.

OPOMBA: Na nekaterih območjih se bo odprl pojavni zaslon, na katerem boste 
morali vnesti kodo za paket strani. Če se to zgodi, se obrnite na strokovnjaka za 
podporo strankam, ki vam bo priskrbel ustrezno kodo.

13 Naprava bo med uveljavljanjem nastavitev prikazala zaslon Machine Self Test In 
Progress. Ko se ta postopek konča, bo prikazan zaslon Basic Copying. Naprava je zdaj 
pripravljena za uporabo.

14 Če je nameščena funkcija za faksiranje, se prikaže zaslon za namestitev faksa. Glejte 
Nastavitev faksa na strani 16.
6 priročnik za hitri začetek uporabe
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WorkCentre 4250/4260

Znotraj naprave
V napravi sta dela, ki ju lahko zamenja 
uporabnik: kartuša s tonerjem (6) in 
kartuša z bobnom (7). 

Serijska številka naprave je na notranji 
strani sprednjega pokrova.

5

2

3 1

Nadzorna plošča: 
zaslon na dotik in 
številčnica.

4

Pladnji za papir: 
pladenj 2 in HCF sta 
standardna pri modelu 
WorkCentre 4250/4260XF, 
pri drugih konfiguracijah 
pa na voljo kot 
dodatna oprema.

Izhodni pladenj: 
zbira natisnjene in 
optično prebrane 
dokumente.

Obvodni pladenj: 
za nestandardne 
tiskalne medije.

Podajalnik 
dokumentov: 
za optično branje več 
dokumentov. Steklo 
za dokumente pod 
podajalnikom se uporablja 
za branje posameznih 
dokumentov, vezanih 
dokumentov ipd.

4

2

5

3

1

6
7
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Pregled nadzorne plošče

Predmet Opis

gumb za domačo 
stran za storitve

Prikaže stran za storitve, na kateri lahko omogočite funkcije.

storitve Omogoča dostop do možnosti funkcij.

stanje posla Prikaz stanja tekočega posla in poslov v čakalnih vrstah.

stanje naprave Dostop do podatkov o napravi, stanju in serijski številki ter 
tiskanje poročil.

zaslon na dotik Prikazuje trenutno stanje naprave in omogoča izbiro 
funkcij naprave.

pomoč Prikaže pomoč za funkcije in sporočila o napakah.

jezik Omogoča izbiro jezika sporočil, prikazanih na zaslonu.

napajanje Preklop naprave iz varčevalnega načina.

prijava/odjava Dostop do skrbniških funkcij.

številčnica Omogoča vnos številskih znakov.

preklic vnosa Prekliče vnos na številčnici.

stanje posla

gumb za domačo 
stran za storitve

stanje
naprave zaslon na dotik

številčnica

preklic vnosa
start

stop

počisti vse
prijava/
odjava

pomoč

jezik

prekinitev tiskanja

storitve napajanje
8 priročnik za hitri začetek uporabe
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Vstavite papir v pladnje za papir
1 Odprite pladenj za papir in vstavite papir 

vanj. Papir naj NE seže čez črto »Max«.
2 Prilagodite vodili, da bo papir potisnjen 

ob desno stran pladnja.
3 Ko zaprete pladenj, bo prikazan zaslon 

Paper Settings. Vnesite velikost, vrsto 
in barvo papirja, ki ste ga vnesli, in 
izberite Confirm.

počisti vse Pritisnite enkrat, da izbrišete trenutni vnos. Pritisnite dvakrat, 
da obnovite privzete nastavitve.

prekinitev tiskanja Omogoča prekinitev tekočega posla, da se natisne 
pomembnejši posel.

stop Prekine tekoči posel.

start Omogoča sprožitev posla.

Predmet Opis

Vodili
priročnik za hitri začetek uporabe 9



Vstavljanje dokumentov
Dokumente lahko naložite v 
podajalnik dokumentov ali 
na steklo za dokumente.

1 Dokumente, ki jih želite kopirati, 
naložite v podajalnik dokumentov s 
potiskano stranjo navzgor in 
zgornjim robom ob levo ali 
spodnjo stran pladnja. 

2 Premaknite vodili za dokumente, tako 
da se bosta komaj dotikali dokumenta,

ali…

3 …odprite podajalnik dokumentov in 
postavite posamezne dokumente s 
potiskano stranjo navzdol na steklo 
za dokumente, tako da bodo 
poravnani z levim spodnjim kotom.

OPOMBA: Dokumenti se optično 
preberejo samo enkrat, četudi 
izberete več kopij.

Vodili
10 priročnik za hitri začetek uporabe
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Priključitev v omrežje
Upoštevajte ta navodila, da napravo priključite v ethernetno omrežje TCP/IP.

Če napravo priključujete v drugo vrsto omrežja ali želite uporabiti drugačne protokole, 
preberite navodila na CD-ju za skrbnike sistema.

Preskusite napravo
Preden napravo priključite v omrežje, se prepričajte, da pravilno deluje kot 
kopirni stroj.

1 V podajalnik dokumentov vstavite dokument in naredite tri kopije.
2 Če naprava uspešno natisne tri izvode dokumenta, priključite omrežno povezavo, 

kot je opisano v nadaljevanju. Če kopiranje ni uspešno, glejte Odpravljanje težav na 
strani 34.

Priključitev v omrežje s protokolom TCP/IP
Omrežno povezavo TCP/IP lahko nastavite na enega od teh načinov:

• DHCP: ta način uporabite, če želite, da strežnik DHCP samodejno nastavi 
naslov IP. To je tovarniško privzeta nastavitev.

• Statični naslov IP: ta način uporabite, če želite ročno nastaviti naslov IP, 
ki vam ga dodeli skrbnik sistema.

Ko vklopite napravo, s protokolom DHCP samodejno ugotovi omrežno konfiguracijo. 
Če želite uporabiti statičen naslov IP, morate izklopiti DHCP ter ročno vnesti naslov IP, 
naslov prehoda, masko podomrežja in naslov strežnika DNS.

1 Priključite ethernetni kabel na priključek 
RJ45 na hrbtni strani naprave. 

OPOMBA: Ethernetnega kabla ne 
dobavlja Xerox. 

2 Če želite naslov nastaviti s protokolom 
DHCP, glejte Omrežna nastavitev s 
protokolom DHCP na strani 12. Če želite 
nastaviti statični naslov IP, preskočite na 
Nastavitev omrežja s statičnim naslovom 
IP na strani 12.

omrežni 
priključek 
RJ45
priročnik za hitri začetek uporabe 11



Omrežna nastavitev s protokolom DHCP
Ko se naprava zažene, se s strežnikom DHCP »dogovori« za naslov IP. Počakajte dve 
minuti, da se konča nastavitev omrežja, nato pa uporabite ta postopek, da preverite 
dodeljen naslov IP:

1 Pritisnite gumb Machine Status. Na strani Machine Status je prikazan naslov IP.
2 Potrdite, da je bil dodeljen naslov IP in da je primeren za vaše omrežje.

OPOMBA: Če se naslov IP začne z 169.xxx.xxx.xxx, strežnik DHCP ni pravilno dodelil 
naslova ali pa v omrežju ni omogočen protokol DHCP. Za pomoč se obrnite na 
skrbnika omrežja.

Nastavitev omrežja s statičnim naslovom IP
Preden začnete, morate od skrbnika omrežja dobiti te podatke:

• naslov IP
• naslov prehoda
• maska podomrežja
• naslov strežnika DNS

1 Na nadzorni plošči pritisnite gumb Log 
In/Out in nato vnesite skrbniško geslo 
[1111] ter izberite Enter.

2 Pritisnite gumb Machine Status, nato 
pa izberite Tools > Connectivity and 
Network Setup > Advanced > 
Network Setting > Network Setup > 
TCP/IP Options.

3 Izberite HTTP in Enable. Izberite Save.
4 Izberite TCP/IP IPv4 SETUP ali TCP/IP 

IPv6 SETUP.
5 Izberite gumb Dynamic Addressing. 

Privzeto je izbrana možnost DHCP. Izberite Disabled, da onemogočite DHCP, in 
nato Save.

6 Izberite Name/Address. Vnesite ime gostitelja (Host Name), tako da izberete znak 
tipkovnice. Vnesite naslov IP (IP Address), tako da se dotaknete posameznih polj in s 
številčnico vnesete številke. Izberite Save.

7 Izberite Subnet and Gateway. Vnesite masko podomrežja (Subnet Mask) in prehod 
(IP Gateway). Izberite Save.

8 Če ne želite nastaviti nastavitev DNS, nadaljujte na naslednjem koraku. Če jih želite 
nastaviti, izberite gumb DNS Configuration. Vnesite podatke za polji Domain 
Name in Preferred DNS Server. Izberite Save.

9 Statični naslov IP je zdaj nastavljen. Pritisnite gumb Log In/Out in izberite Confirm, 
da se odjavite in zaprete meni Tools.
12 priročnik za hitri začetek uporabe
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Namestite tiskalniške gonilnike
V tem razdelku je opisan postopek namestitve gonilnikov za tiskalnik s CD-ja s 
tiskalniškimi gonilniki.

OPOMBA: Če želite namestiti druge gonilnike ali uporabljate drug operacijski 
sistem, najdete podrobne informacije na CD-ju za skrbnike sistema.

Tiskalniški gonilniki so na CD-ju Drivers CD, ki ste ga dobili z napravo. 

Drivers CD lahko uporabite za hkratno namestitev več komponent, kot so tiskalniški 
gonilniki, uporabniška dokumentacija in opisi tiskalnikov PPD (PostScript® Printer 
Description). Če želite uporabiti namestitveni program, vstavite disk Drivers CD-ROM, 
ki ste ga dobili z napravo.

1 V pogon CD odjemalske delovne postaje vstavite disk Driver CD.
2 Če se CD ne zažene samodejno, v meniju Start kliknite Run (Zaženi) in prebrskajte 

do pogona CD. Kliknite možnost Setup in nato OK (V redu). Kliknite OK (V redu), 
da začnete postopek namestitve.

3 Izberite jezik namestitve in kliknite Continue. Prikaže se zaslon za gonilnike.

OPOMBA:  Možnosti, ki so na voljo:
Install Print and Scan Drivers – namesti gonilnike za tiskalnik in optični bralnik.
Install Print Driver – namesti samo gonilnike za tiskalnik.
Install Scan Driver – namesti samo gonilnike za optični bralnik.

Upoštevajte spodnja navodila, da namestite gonilnike za tiskalnik.
4 Kliknite Install Drivers.
5 Kliknite Install Print Drivers.

OPOMBA: Privzeto se namesti gonilnik PCL 6.

6 Če želite namestiti gonilnik PCL 5 ali PS, kliknite Option in potrdite polja za 
želene gonilnike.

7 Vnesite tiskalnikov naslov IP, ime DNS ali pot UNC za napravo.
8 Kliknite Install.
9 Upoštevajte navodila, prikazana na zaslonu, da končate namestitev.
10 Ko je tiskalniški gonilnik uspešno nameščen, natisnite preskusni dokument 

neposredno iz gonilnika ali pa pošljite tiskalni posel tiskalniku 
WorkCentre 4250/4260 Series.

11 Če je tiskanje uspešno, nadaljujte z naslednjim namestitvenim postopkom v tem 
dokumentu. Če tiskanje ni uspelo, glejte Odpravljanje težav na strani 34.

Podrobno razlago najdete na CD-ju za skrbnike sistema, ki ste ga dobili z napravo.
priročnik za hitri začetek uporabe 13



Nastavitev e-pošte
Uporabite ta postopek za nastavitev e-poštne storitve. Če te storitve še ne želite 
nastaviti, nadaljujte v razdelku Nastavitev faksa na strani 16.

OPOMBA: Če na zaslonu »Services Home« ne vidite gumba »E-mail«, v razdelku 
»Tools Pathway« omogočite funkcijo za e-pošto. (Pritisnite Log In/Out > 
Password [1111] > Enter > Machine Status > Tools > User Interface > 
Service Enablements > E-mail > Enable).

Preden začnete postopek nastavitve, se prepričajte, da so na voljo naslednji elementi 
oziroma da so bili izvedeni navedeni postopki:
• Preverite, ali delujejo vse omrežne funkcije naprave in je na zaslonu 

Services Home na voljo storitev e-pošte.
• Preverite, ali sta na napravi nastavljena in delujeta protokola TCP/IP in HTTP. 

Glejte Nastavitev omrežja s statičnim naslovom IP na strani 12.
• Pridobite naslov IP delujočega poštnega strežnika SMTP, ki sprejema dohodni 

poštni promet.
• Preverite, ali so nastavitve DNS pravilno nastavljene in po potrebi pridobite 

naslov imena domene.
• Ustvarite e-poštni račun, ki ga bo naprava uporabljala kot privzeti naslov Od.
• Preskusite e-poštni naslov tako, da na račun naprave Xerox pošljete e-poštno 

sporočilo. Ta postopek izvedite na poštnem odjemalcu v svojem omrežju, 
ki podpira protokola SMTP (Simple Mail Transfer Protocol) in POP3 
(Post Office Protocol 3). 

E-poštne nastavitve konfigurirajte s storitvami CentreWare Internet Services, ki so 
dostopne s spletnim brskalnikom.

1 Odprite spletni brskalnik in v naslovno vrstico vnesite naslov TCP/IP naprave. 
Pritisnite Enter.

2 Kliknite Properties > Connectivity > Protocols > TCP/IP.
3 V polje Domain Name vnesite ime domene (na primer: abc.xyz.podjetje.com). 

Nastavitve DNS je treba konfigurirati samo, če uporabljate imena gostiteljev.

OPOMBA: Če je na napravi omogočeno dinamično naslavljanje (DHCP ali BootP), 
ime domene ne bo dostopno. Če ga morete spremeniti, na menijskem seznamu »IP 
Address Resolution« kliknite Static. 

4 Premaknite se na spodnji del zaslona in kliknite gumb Apply, da 
uveljavite spremembe. 

5 Vnesite trenutno uporabniško ime (User Name) in geslo (Password) za 
skrbniška orodja. 
Privzeto ime je [admin] (upoštevajte velike in male črke), geslo pa [1111].

6 V meniju Protocols kliknite SMTP Server. 
7 Kliknite IP Address ali Host Name in vnesite vrednost v polje Host Name ali IP 

Address ter številko vrat strežnika SMTP v polje Port Number (1-65535). Privzeta 
vrednost za ta vrata je 25.
14 priročnik za hitri začetek uporabe
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8 Če je treba, potrdite polje Server Requires SMTP Authentication.
9 Vnesite ustrezne vrednosti v polji Login Name in Password.
10 Kliknite Apply, da potrdite nastavitve.
11 V meniju Properties kliknite Services > E-mail Settings > Defaults.
12 Če želite dopolniti vrednosti na zaslonu za nastavitev e-pošte, kliknite Edit 

za vsako skupino možnosti.

OPOMBA: Če želite iz naprave pošiljati e-poštna sporočila, morate v polje 
From: vnesti naslov. V skupini General kliknite Edit, da nastavite privzet naslov 
za polje From:.

13 Ko končate vse nastavitve, kliknite Apply.

OPOMBA: Več informacij o vseh e-poštnih funkcijah, skupaj z nastavitvami za 
imenike, najdete na CD-ju za skrbnike sistema.
priročnik za hitri začetek uporabe 15



Nastavitev faksa
Pri konfiguraciji naprav WorkCentre 4250X/XF in 4260X/XF Series je faks standardno 
nameščen. Če komplet za faksiranje ni v standardni opremi, ga bo treba 
posebej nastaviti.

Nastavitev kompleta za faksiranje
1 Navodila za nastavitev kompleta so priložena kompletu.
2 Priključite telefonsko linijo na 

priključek Line na napravi.
3 Če želite na napravo priključiti 

slušalko, uporabite priključek Ext.
4 Na nadzorni plošči pritisnite 

gumb Log In/Out in nato 
vnesite skrbniško geslo [1111] 
ter izberite Enter.

5 Pritisnite gumb Machine Status 
in nato izberite Tools > 
User Interface > 
Service Enablements > 
Embedded Fax. Prikazan bo 
zaslon »Fax Install Screen«.

6 Izberite želeno (ali najbližjo) državo na seznamu Country Setup in nato Next.
7 Izberite želeni način klicanja. Za tonsko linijo izberite Tone. Za impulzno linijo 

(10 impulzov/s.) izberite Pulse. Če niste prepričani, izberite Tone.
8 Izberite znak številčnice za polje Fax Number in vnesite telefonsko številko faksa 

za napravo.
9 Izberite znak številčnice za polje Machine Name in vnesite ime po meri za napravo.
10 Izberite Save in Close. Naprava se bo znova zagnala. Naprava bo zdaj pošiljala in 

sprejemala fakse s privzetimi nastavitvami. Če želite spremeniti nastavitve faksa, 
odprite razdelek »Tools Pathway«, kot je opisano v 4. in 5. koraku, ter izberite Tools > 
User Interface > Fax Service Settings. Izberete in spremenite lahko različne 
možnosti faksa.

tel. linija
(Line)

slušalka
(Ext.)
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Namestitev kompletov za dodatne funkcije
V tem razdelku so navodila za namestitev in nastavitev dodatnih funkcij:

• omrežno obračunavanje,
• strežniški faks.

OPOMBA: Podrobnejša navodila za namestitev in nastavitev funkcij strežniškega 
faksa in omrežnega obračunavanja najdete na CD-ju za skrbnike sistema.

Namestitev kompletov za dodatne funkcije
Vsi kompleti za dodatno opremo se namestijo na enak način ter vsebujejo ključ za 
omogočanje funkcije in navodila.

1 Ko je naprava vklopljena, vstavite ključ za 
omogočanje funkcije v režo bralnika kartic 
na hrbtni strani naprave. Zasvetile bodo 
lučke na ključu za omogočanje funkcije 
(najprej rdeča, nato utripajoča zelena 
in nato neprekinjena zelena).

2 Ko je funkcija uspešno nameščena, se bo odprlo 
pojavno sporočilo, da je funkcija nastavljena in 
lahko odstranite ključ za omogočanje funkcije.

Omrežno obračunavanje
Omrežno obračunavanje omogoča upravljanje rabe naprave z možnostjo podrobne 
analize stroškov. 
Naprava evidentira vse posle tiskanja, optičnega branja in kopiranja ter jih shrani v 
dnevnik poslov. Uporabniki morajo za dostop do naprave vnesti ID uporabnika in 
računa, opravljeni posli pa se shranjujejo v dnevniku poslov.

Namestitev kompleta

Namestite komplet. Glejte Namestitev kompletov za dodatne funkcije na strani 17.

Omogočite omrežno obračunavanje

1 Na nadzorni plošči pritisnite gumb Log In/Out in nato vnesite skrbniško geslo 
[1111] ter izberite Enter.

2 Pritisnite gumb Machine Status in nato izberite Tools > Accounting > 
Accounting Enablement > Authentication Mode.

3 V razdelku »Network Accounting« izberite gumb On.
4 Izberite Save.
5 Pritisnite gumb Log In/Out in izberite Confirm, da se odjavite.

OPOMBA: Več informacij najdete v vodniku za skrbnike sistema.

reža bralnika
kartic
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Strežniški faks
Funkcija strežniškega faksa omogoča uporabnikom pošiljanje dokumentov enemu 
ali več faksom po telefonskem omrežju, ne da bi bilo treba napravo priključiti na 
posebno telefonsko številko samo za faks. To se izvede s povezavo naprave na 
omrežni faksni strežnik, ki lahko upravlja pošiljanje faksov po celotni organizaciji.

Namestitev kompleta

1 Namestite komplet. Glejte Namestitev kompletov za dodatne funkcije na strani 17.

Omogočite strežniški faks

2 Na nadzorni plošči pritisnite gumb Log In/Out in nato vnesite skrbniško geslo 
[1111] ter izberite Enter.

3 Pritisnite gumb Machine Status in nato izberite Tools > User Interface > 
Service Enablements > Server Fax. 

4 Izberite Enable.
5 Izberite Save.
6 Pritisnite gumb Log In/Out in izberite Confirm, da se odjavite in zaprete meni Tools.

OPOMBA: Več informacij najdete v vodniku za skrbnike sistema.
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Kopiranje
1 Naložite dokumente, ki jih želite kopirati, v 

podajalnik dokumentov s potiskano stranjo 
navzgor oziroma na steklo za dokumente s 
potiskano stranjo navzdol.

2 Pritisnite gumb Services Home, nato 
pa Copy. Prikazan bo zaslon Copy.

3 Izberite želene funkcije na zaslonu na dotik.

Te so prikazane v spodnji tabeli.

4 S številčnico vnesite želeno število strani in pritisnite Start.

OPOMBA: Kopiranje potrdite tako, da na nadzorni plošči pritisnete Job Status, da 
prikažete zaslon s stanjem posla. Čakajoči posel kopiranja bo prikazan v čakalni vrsti.

Copy Image Quality Layout 
Adjustment Output Format

Reduce / Enlarge 
Pomanjšanje ali 
povečanje slike od 
25 % do 400 %.

Original Type 
Izberite, ali je na 
izvirniku besedilo, 
besedilo in 
fotografije ali 
samo fotografije, 
da optimirate 
nastavitev ločljivosti.

Original Size
Izberite velikost 
izvirnika.

Booklet Creation 
Samodejno tiskanje 
dokumenta v obliki 
knjižice.

Paper Supply 
Izberite pladenj/
velikost papirja.

Lighten / Darken 
Posvetlite ali 
potemnite natisnjen 
dokument.

Book Copying 
Kopiranje 
vezanih 
dokumentov.

Covers
Vstavite platnice.

2-Sided Copying
Izberite eno- ali 
obojestransko 
kopiranje.

Background 
Suppression
Samodejno 
zmanjšanje ali 
odpravljanje 
temnega ozadja.

Image Shift 
Premaknite sliko 
na strani.

Transparency 
Separators
Vstavite prazne ali 
potiskane ločilne strani 
med posamezne 
prosojnice.

Copy Output
Možnosti zbiranja 
in spenjanja.

Edge Erase
Izbriše robove 
slike.

Page-layout
Tiskanje več strani 
na en list.

Store Job
Shrani posel v napravi.
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Dodatne kopirne funkcije
Povečava/pomanjšava

Izvirnike lahko povečate ali pomanjšate od 25 % do 400 %. 
Če želite uporabiti to možnost, izberite zavihek Copy. Izberite 
enega od vnaprej nastavljenih razmerij pomanjšave/povečave 
ali pa More, da izberete poljubno vrednost.

Nastavitev kakovosti slike
Kakovost natisnjenih kopij lahko nastavite glede na kakovost 
izvirnika, ki se optično bere. Če želite uporabiti to možnost, 
izberite zavihek Image Quality.

Original Type: Izberite vrsto dokumenta, ki ga želite kopirati – 
»Text« (besedilo), »Text and Photo« (besedilo in fotografije) ali 
»Photo« (fotografije).

Lighten / Darken: Prilagodite svetlost ali temnost 
natisnjenega dokumenta. 

Background Suppression: Uporabite za samodejno zmanjšanje 
ali odpravo temnega ozadja, ki je posledica kopiranja izvirnikov 
na barvnem papirju ali časopisov. 

Tiskanje knjižic
Kopirate lahko zaporedne komplete eno- ali obojestranskih 
izvirnikov, tako da naredite priročne knjižice. Naprava samodejno 
izdela obojestranske izpise, ki jih lahko prepognete, da naredite 
knjižico z vsemi stranmi v pravilnem zaporedju. Naprava prav 
tako samodejno zmanjša in nastavi položaj posameznih slik, 
da so poravnane na izbranem papirju. 

Če želite uporabiti to možnost, vstavite izvirnike v podajalnik 
dokumentov in izberite zavihek Output Format, nato pa 
Booklet Creation. 

Več slik na stran
Ta funkcija se uporablja za kopiranje dveh ali več pomanjšanih 
dokumentov na en list papirja. Primerna je za tiskanje izročkov, 
snemalnih knjig in dokumentov, ki se uporabljajo za arhiviranje. 
Če želite uporabiti to možnost, vstavite izvirnike v podajalnik 
dokumentov in izberite zavihek Output Format, nato pa 
Page Layout. Na en list papirja lahko kopirate enega, dva 
ali štiri različne izvirnike.
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Tiskanje dokumenta
1 Preverite, ali je v računalniku nameščen ustrezen gonilnik za tiskalnik. Navodila za 

namestitev gonilnika najdete v razdelku Namestite tiskalniške gonilnike na strani 13.

Tiskalniške gonilnike najdete tudi na disku Drivers CD ali jih prenesete s Xeroxovega 
spletnega mesta na naslovu www.xerox.com/support.

2 Odprite dokument, ki ga želite natisniti. Kliknite File > Print in na prikazanem 
seznamu tiskalnikov izberite Xerox WorkCentre 4250/4260 Series.

3 Če želite spremeniti privzete lastnosti tiskanja, kliknite Properties (Lastnosti).

Tiskalniški gonilnik ima več zavihkov 
z možnostmi in lastnostmi.

• Na zavihku Paper/Output 
izberite vrsto posla in tiskalnega 
medija, velikost in barvo 
ter možnosti tiskanja 
(npr. obojestransko tiskanje). 

• Na zavihku Layout/Watermark 
so različne možnosti za dodajanje 
vodnega žiga, spreminjanje 
usmeritve strani (ležeče ali 
pokončno) ter tiskanja knjižic 
ali več strani na list.

• Na zavihku Advanced so različn emožnosti za pisave in tiskanje, kot je 
pomanjšava in pomanjšava slike.

Izberite želene možnosti za tiskalni posel in pritisnite OK, da natisnete dokument.
4 Tiskalni posel bo poslan napravi in bo v čakalni vrsti Active Jobs, dokler se ne natisne. 

Če si želite v napravi ogledati čakalno vrsto, na nadzorni plošči pritisnite gumb 
Job Status.
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Dodatne tiskalne funkcije
Zasuk slike

Omogoča zasuk slike za 180 stopinj. Če želite uporabiti to možnost, 
kliknite zavihek Advanced, nato pa še Image Options. Izberite 
Enabled, da slike zasukate za 180 stopinj. Izberite Disable, da 
izklopite funkcijo.

Shranjene nastavitve
Pogosto (ali redko) uporabljene funkcije tiskalnega posla lahko 
shranite z možnostjo Saved Settings. Z njo lahko poimenujete, 
shranite in prikličete skoraj vse funkcije tiskalnega posla, ki jih je 
mogoče izbrati. Shranite lahko do 50 različnih nastavitev posla. 
Če želite uporabiti to možnost, kliknite zavihek Paper/Output, 
nato Save Settings in še puščico navzdol. Izberite Save As, 
da shranite trenutne nastavitve ali izberete že shranjene.

Prihranite toner
Če tiskate osnutke dokumentov, lahko s funkcijo Draft Mode 
zmanjšate porabo tonerja (suhega črnila). Natisi bodo svetlejši 
kot običajno, vendar povsem berljivi in primerni za preverjanje 
dokumentov. Za varčevanje tonerja kliknite zavihek Advanced 
in odprite možnost Image Options. V razdelku Draft Mode 
izberite On.

Vodni žigi
Funkcija Watermark omogoča, da ustvarite in čez strani dokumentov 
natisnete odpadno besedilo ali slike. Ustvarite lahko nove vodne 
žige ali uredite obstoječe. Izberete lahko tudi, ali naj se vodni žigi 
natisnejo v ozadju ali ospredju, in tiskanje vodnih žigov samo na 
prvi strani. Če želite uporabiti to funkcijo, kliknite zavihek Layout/
Watermark, nato pa ustrezne možnosti v razdelku Watermark.
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Pošiljanje faksa
OPOMBA: Ta možnost je sicer na voljo pri vseh napravah, pri modelih WorkCentre 
4250X/XF in 4260X/XF pa je standardna. 

1 Dokumente, ki jih želite faksirati, naložite v podajalnik dokumentov s potiskano 
stranjo navzgor oziroma na steklo za dokumente s potiskano stranjo navzdol.

2 Pritisnite gumb Services Home 
in izberite možnost Fax. S tem 
prikažete zaslon Fax.

3 Vnesite številko prejemnikovega 
faksa na enega od teh načinov:

• Vnos s številčnico – na zaslonu 
na dotik izberite območje 
»Enter Number« in s številčnico 
vnesite številko.

• Ročni vnos – če je na napravo 
priključena telefonska slušalka, izberite možnost »Manual Dial« in vnesite 
številko na slušalki ali številčnici.

• Hitro izbiranje – izberite »Speed Dial«, nato pa vnaprej nastavljeno številko 
za hitro izbiranje.

• Možnost »Add« – na seznam za pošiljanje dodajte več prejemnikov, ki jim 
želite poslati faks. Ta gumb omogoča dostop do klicnega imenika za 
posameznike in skupine.

Želene funkcije za faksni posel izberite v naslednji tabeli: 

Faks Image Quality Layout 
Adjustment  Fax Options

2-Sided Scanning
Eno- ali obojestranski 
izvirniki.

Lighten / Darken
Posvetlite ali 
potemnite izpis.

Original Size
Nastavite velikost 
izvirnika.

Store for Polling
Shrani faks v lokalni 
napravi.

Original Type
Izberite, ali je na 
izvirniku besedilo, 
besedilo in 
fotografije ali 
samo fotografije, 
da optimirate 
nastavitev ločljivosti.

Background 
Suppression
Samodejno 
zmanjšanje ali 
odpravljanje 
temnega ozadja.

Remote Polling
Prenesite fakse iz 
oddaljenih naprav.

Resolution
Nastavite kakovost 
slike.

Color Mode
Črno-belo ali 
barvno optično 
branje.

Delay Send
Nastavite, kdaj naj 
bo faks poslan.
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4 Pritisnite Start, da pošljete faks.

OPOMBA: Faksiranje potrdite tako, da na nadzorni plošči pritisnete Job Status, 
da prikažete zaslon s stanjem posla. Prikazan bo posel v čakalni vrsti. 

Send Header Text
Dodajte podatke na 
začetek faksa.

Mailboxes
Pošljite faks v lokalni 
ali oddaljeni poštni 
predal.

Fax Sending 
Features
Nastavite hitrost 
prenosa pri začetku 
oddajanja faksa.

Poročila o 
faksiranju
Izberite poročilo o 
potrditvi ali napaki 
faksa.

Faks Image Quality Layout 
Adjustment  Fax Options
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Dodatne faksne funkcije
Odloženo pošiljanje

Ta funkcija omogoča nastavitev ure, ko bo faks poslan. Z njo lahko 
začasno odložite pošiljanje faksnega posla na uro, ko so klici cenejši. 
Če želite uporabiti to možnost, izberite zavihek Fax Options. 
Izberite Fax Options > Delayed Send. 

Spremenite ločljivost
Ločljivost vpliva na videz faksa na prejemnikovi strani. Če želite 
uporabiti to možnost, izberite zavihek Fax in nato še razpoložljive 
možnosti v razdelku Resolution. Za večino besedilnih dokumentov 
lahko izberete možnost Standard, za črtne risbe in fotografije Fine, 
za slike in fotografije velike ločljivosti pa Superfine.

Nastavitev adresarja
S to funkcijo lahko v napravi shranite imena in številke faksa 
prejemnikov. Vnose, shranjene tukaj, boste lahko izbrali v funkciji 
Send List na zavihku Fax options. Izberite zavihek Fax, nato 
pa Address Book. Vnesite podrobnosti faksa za posameznike 
(Individual). Nastavite lahko tudi klicne skupine (Groups), 
sestavljene iz več vnosov vrste Individual.

Poročila o faksiranju
Natisnete lahko številna različna poročila o faksiranju. Za dostop do 
različnih možnosti poročil o faksiranju izberite zavihek Fax Options, 
nato pa Fax Reports. Izberite želeno poročilo o faksiranju.

Pritisnete lahko tudi gumb Machine Status in izberete 
Machine Information > Information Pages >, nato pa 
izberete želeno poročilo.

 

 

 

priročnik za hitri začetek uporabe 25



Optično branje po omrežju
Optično branje po omrežju omogoča optično branje papirnih dokumentov in njihovo 
shranjevanje v obliki elektronskih datotek.

1 Dokumente, ki jih želite optično prebrati, naložite v podajalnik dokumentov 
s potiskano stranjo navzgor oziroma na steklo za dokumente s potiskano 
stranjo navzdol.

2 Na nadzorni plošči pritisnite gumb 
Services Home. Izberite možnost 
Network Scanning. S tem prikažete 
zaslon Network Scanning.

3 Na seznamu izberite želeno 
predlogo optičnega branja.

4 Če je treba, spremenite nastavitve 
predloge z možnostmi na zavihkih 
Network Scanning, Advanced 
Settings, Layout Adjustment in Filing Options.

Network Scanning Advanced 
Settings

Layout 
Adjustment Filing Options

Output Color
Črno-belo, sivinsko ali 
barvno optično 
branje.

Lighten / Darken 
Posvetlite ali 
potemnite 
natisnjen 
dokument.

Original Size
Nastavite velikost 
izvirnika.

File Name
Če ime datoteke 
že obstaja.

2-Sided Scanning
Izvirnik je lahko eno- 
ali obojestranski, 
drugo stran je 
mogoče zasukati. 

Background 
Suppression
Samodejno 
zmanjšanje ali 
odpravljanje 
temnega ozadja.

Scan to Edge
Optično branje 
celotne strani

Document 
Management 
Fields
Vnesite indeksne 
podatke 
dokumenta

Original Type
Besedilo, fotografije 
ali besedilo in 
fotografije

Resolution
Od 72 × 72 do 
600 × 600 pik 
na palec (dpi)

Add File 
Destinations
Dodajte datotečne 
cilje kateri koli 
predlogi
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5 Pritisnite Start, da optično preberete dokumente.

OPOMBA: Optično branje potrdite tako, da na nadzorni plošči pritisnete Job Status, 
da prikažete zaslon Job Status. Prikazan bo posel v čakalni vrsti. 

Resolution
Prilagodi nastavitve 
optičnega branja 
glede na namen 
optično prebrane slike

Quality/File Size 
Optimalna 
kakovost glede na 
velikost datoteke

File format
Oblika zapisa 
datoteke: PDF, TIF 
ali JPEG

Update 
Templates
Uporabite 
nedavno 
ustvarjeno ali 
posodobljeno 
predlogo, preden 
jo sistem 
samodejno doda 
na seznam predlog

Network Scanning Advanced 
Settings

Layout 
Adjustment Filing Options
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Dodatne možnosti za optično branje 
po omrežju

Priprava predlog za optično branje
Predloge se pri optičnem branju po 
omrežju uporabljajo za določanje cilja in 
nastavitev posla optičnega branja. Če za 
najpogostejše posle optičnega branja 
pripravite posamezne predloge, bo vaš 
potek dela učinkovitejši.

Nove predloge temeljijo na nastavitvah, 
konfiguriranih za privzeto predlogo, 
lahko pa tudi kopirate in prilagodite 
obstoječe predloge. Prikazati je 
mogoče do 250 predlog.

1 Odprite spletni brskalnik in v naslovno vrstico vnesite naslov TCP/IP naprave. 
Pritisnite Enter in kliknite zavihek Scan.

2 V polju Template Name okna General Information vnesite ime predloge. Dodate 
lahko tudi opis in ime lastnika.

3 Kliknite Add, da ustvarite novo predlogo. Prikazana bo na seznamu Templates na 
levi strani.

Ime/oblika

4 Če želite izbrati ime in obliko optično prebranega dokumenta, kliknite Edit. Vnesite 
ime za optično prebrani dokument in izberite obliko zapisa datoteke: TIFF, mTIFF, 
JPEG ali PDF. Kliknite Apply.

Ciljne storitve

5 Optično prebran dokument lahko pošljete v datotečno shrambo, ki jo nastavi skrbnik 
sistema, ali ga pošljete po faksu, če je v napravi omogočena možnost Server Fax. 
Kliknite File in/ali Fax. Če kliknete »File«, izberite datotečno shrambo, v katero bodo 
poslane optično prebrane slike.

Document Management Fields

6 Če želite dodati podatke za lažje upravljanje optično prebranih slik, kliknite Add in 
vnesite ustrezne podatke.

Možnosti optičnega branja

7 Če želite spremeniti možnosti optičnega branja, kliknite Edit. Nastavili boste lahko 
možnosti 2-Sided in Original Type ter vrsto dodatnih nastavitev optičnega branja, kot 
so Lighten/Darken, Color Options, Original Input in Resolution. Izberete lahko tudi 
tiskanje potrditvenega poročila in dnevnika poslov.

8 Ko končate vse nastavitve, kliknite Apply. 
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Pošiljanje e-pošte
1 Dokumente, ki jih želite poslati po e-pošti, naložite v podajalnik dokumentov 

s potiskano stranjo navzgor oziroma na steklo za dokumente s potiskano 
stranjo navzdol.

2 Na nadzorni plošči pritisnite gumb 
Services Home.

3 Izberite možnost E-mail.
4 Izberite From in vnesite naslov, 

kateri želite, da je v polju Od 
e-poštnega sporočila.

OPOMBA: To polje je lahko že 
vnaprej nastavil skrbnik in ga ni 
mogoče spreminjati.

5 Izberite New Recipient in vnesite e-poštni naslov prejemnika. Če je nastavljen 
adresar, izberite Address Book in vnesite ime prejemnika. Naprava bo preiskala 
adresar in prejemnika boste lahko izbrali na prikazanem seznamu imen. Na ta način 
lahko v polje Address List dodate več prejemnikov.

6 Na zavihkih E-mail, Advanced Settings, Layout Adjustment ali E-mail Options 
izberite vse nastavitve, primerne za vaš dokument.

E-pošta Advanced 
Settings

Layout 
Adjustment Možnosti e-pošte

Output Color
Barva izpisa je lahko 
črno-bela, sivinska ali 
barvna 

Lighten / Darken
Posvetlite ali 
potemnite izpis

Original Size
Nastavite velikost 
izvirnika.

File format
Oblika zapisa 
datoteke: PDF, TIF 
ali JPEG

2-Sided Scanning
Izvirniki so lahko eno- 
ali obojestranski 

Background 
Suppression
Odstranite temna 
ozadja

Scan to Edge
Optično branje 
celotne strani

Reply To
Nastavite e-poštni 
naslov
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7 Pritisnite Start, da optično preberete dokument in ga pošljete kot e-poštno prilogo.

OPOMBA: Posel potrdite tako, da na nadzorni plošči pritisnete Job Status. Posel bo 
prikazan v čakalni vrsti poslov. 

Original Type
Izberite vrsto izvirnika: 
besedilo, fotografija 
ali fotografija in 
besedilo

Quality/File Size 
Optimalna 
kakovost glede na 
velikost datoteke

Message
Vnesite pripombe 
za sporočilo

Resolution
Od 72 × 72 do 
600 × 600 pik na 
palec (dpi)

Resolution
Od 72 × 72 do 
600 × 600 pik na 
palec (dpi)

E-pošta Advanced 
Settings

Layout 
Adjustment Možnosti e-pošte
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Dodatne e-poštne funkcije
Barvne priloge

Ko je izbrana možnost za barvno optično branje, lahko e-pošti dodate 
barvno prilogo v obliki JPEG. Ta oblika zapisa omogoča stikanje 
barvnih bitnih slik.

Če želite omogočiti barvno optično branje v e-pošto, izberite zavihek 
E-mail in izberite možnost Output Color. Izberite Full Color.

OPOMBA: Največja ločljivost barvnih slik je 300 × 300 dpi.
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Povečajte učinkovitost naprave WorkCentre
WorkCentre 4250/4260 Series je zmogljiva večnamenska naprava s številnimi 
digitalnimi funkcijami, združenimi v kompakten sistem. Namenjena je večjim 
delovnim skupinam v različnih produkcijskih okoljih. S temi funkcijami za izboljšanje 
storilnosti omogoča, da z učinkovitejšim potekom dela z manj naredite več.

Prilagodite napravo

Elektronski adresar

Oddaljeno skrbništvo

Napravo lahko nastavite ustrezno poteku dela v pisarni. Na primer, nastavite 
lahko, da je začetni zaslon prikazan, ko pridete k napravi, bodisi Machine 
Status, Job Status ali eden od zaslonov Services. Privzete nastavitve za 
vsakega od zaslonov »Services« lahko prilagodite svojim potrebam glede 
privzetega pladnja za papir, razmerij pomanjšave in obojestranskega 
tiskanja za varčevanje s papirjem. 
Če želite raziskati možnosti, odprite razdelek Tools in si oglejte razdelka 
Feature Defaults in Copy Service Settings.

Adresar je zelo priročen, če imate seznam pogostih prejemnikov faksov ali 
e-pošte. S to funkcijo lahko v imenik programirate podrobnosti 
prejemnikov (npr. e-poštne naslove ali številke faksov). Številke naslovov, 
registrirane v adresarju, lahko uporabite tudi kot kode za hitro klicanje.

Če jo ustrezno nastavite, lahko naprava podpira tudi imenike podjetja 
(LDAP) in lokalne adresarje. Lokalne adresarje lahko uvozite iz datoteke 
.csv v razdelku Internet Services > Properties > Services > 
E-mail Settings.

Večnamenska naprava ima vdelan spletni strežnik z mestom 
CentreWare Internet Services. Do njega lahko dostopate s spletnim 
brskalnikom. Kot uporabnik si lahko z udobja vašega namizja 
ogledate podatke o napravi in morebitne posle, poslane napravi. 
Zavihki na spletni strani vsebujejo različne možnosti za pregled stanja 
naprave, medijev v njej, poslov v čakalni vrsti in skrbniških nastavitev. 
S to funkcijo lahko celo pošljete tiskalni posel po internetu.
Preprosto odprite spletni brskalnik in vnesite naslov IP naprave.
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Pošljite papirne dokumente po e-pošti

Preprosto upravljanje potrošnega materiala

Zapleteni dokumenti

Optično prebrane dokumente lahko kot e-poštne priloge pošljete izbranemu 
e-poštnemu prejemniku ali prejemnikom. Dostop do e-poštnih funkcij je mogoč z 
gumbom Services Home na nadzorni plošči in možnostjo E-mail na zaslonu. 
To je odlična funkcija za optično branje dokumentov za lastno uporabo. 
Preprosto izberite e-poštno funkcijo, vnesite svoj e-poštni naslov in optično 
preberite dokument. Že nekaj sekund pozneje bo v vašem e-poštnem nabiralniku.

Potrošni material so deli naprave, ki jih je treba redno obnavljati ali zamenjati, 
kot so papir, sponke in deli, ki jih lahko zamenja uporabnik. Dele, kot sta kartuši 
s stonerjem in s sponkami, lahko zamenja uporabnik, kar pomeni, da jih lahko 
nadomestite, ne da bi vam bilo treba klicati Xeroxovega zastopnika. Tako se 
skrajša čas, ko tiskalnik ne deluje.

Ta naprava ni zgolj običajni tiskalnik in uporabite jo lahko za tiskanje in izdelavo 
dokumentov, prilagojenih vašim potrebam, najsi gre za predstavitev, izročke in 
podobno. 

Na primer, funkcija Booklet Creation omogoča izdelavo knjižic ali večstranskih kopij 
iz eno- ali obojestranskih izvirnikov. Vezane izvirnike lahko v barvi optično preberete 
in si jih pošljete po e-pošti za vključitev v elektronske dokumente. S funkcijo Multi-up 
lahko izdelate predstavitvene pakete in še veliko več. Omejuje vas le domišljija.
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Odpravljanje težav
Na kakovost izpisov lahko vpliva več dejavnikov. Za optimalno delovanje upoštevajte 
smernice v uporabniškem priročniku. Dokumentacijo in sporočila o napakah, 
prikazana na napravi, lahko uporabite za preprosto iskanje in odpravljanje težav. 

Nekatere napake lahko odpravite z izklopom in vnovičnim vklopom naprave. 
Počakajte približno 20 sekund, preden spet VKLOPITE napravo. Če z vnovičnim 
zagonom ne odpravite težave, si oglejte spodnje tabele z rešitvami.

Težava Rešitev

Naprava se ne vklopi • Preverite, ali je naprava v varčevalnem načinu, kar označuje zelena 
lučka na nadzorni plošči. Dotaknite se zaslona uporabniškega 
vmesnika, da znova vklopite napravo.

• Preverite, ali je napajalni kabel pravilno nameščen.
• Pritisnite gumb za vklop v VKLOPLJEN položaj (I).

Dokumenti se ne 
podajajo skozi 
podajalnik
dokumentov

• Preverite, ali so z izvirnikov odstranjene morebitne sponke.
• Prepričajte se, da ni preseženo največje število dokumentov v 

podajalniku dokumentov (največ 100 dokumentov). 
• Preverite, ali so vodila robov prilagojena tako, da se dotikajo 

robov izvirnikov.

Naprave ne tiska iz 
delovne postaje

• Preverite, ali je na delovno postajo priključen aktivni omrežni kabel.
• Preverite, ali je omrežna nastavitev pravilna. Glejte Priključitev v 

omrežje na strani 11.

Ni mogoče poslati 
e-pošte

• Preverite, ali je naprava povezana v omrežje kot tiskalnik.
• Preverite, ali je e-pošta omogočena. Glejte Nastavitev e-pošte na 

strani 14.

Zagozdenje papirja • Naložite papir v pladnje za papir tako, da bo bleščeča stran papirja 
obrnjena navzgor.

• Papir, naložen v obvodni pladenj, mora biti obrnjen z bleščečo 
stranjo navzdol.

• Če se papir čezmerno kodra, ga obrnite v pladnju.
• Uporabite papir iz svežega paketa.

Dokumenta ni 
mogoče faksirati

• Preverite, ali je naprava priključena na delujočo telefonsko linijo in 
je slišati znak centrale.

• Preverite, ali je omogočen faks. Glejte Nastavitev faksa na strani 16.
34 priročnik za hitri začetek uporabe



sl
ov

en
šč

in
a

Zagozdenje papirja
Mesto zagozdenja bo prikazano na zaslonu. 

• Upoštevajte navodila na zaslonu, da z 
območja poti papirja očistite 
zagozden papir. 

• Poskrbite, da bodo vsa vratca in 
pokrovi območja, kjer ste odpravljali 
zastoj, spet nameščeni v ustreznih 
položajih. 

OPOMBA: Območja odpravljanja 
zagozdenega papirja se lahko razlikujejo glede 
na model in konfiguracijo naprave.

p

 

območje 
utrjevalne 
enote

območje 
zagozdenja 
papirja

Zagozdenje v območju 
stranskega pokrova

1b 1a 1c

Zagozdenje na območju 
dokončevalne enote
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Zagozdenja dokumentov
Na zaslonu bo prikazano mesto zagozdenja dokumenta.

• Upoštevajte navodila na zaslonu in iz podajalnika dokumentov in s stekla za 
dokumente odstranite vse dokumente. Spodnja slika prikazuje območja, kjer 
se odpravijo zagozdenja v podajalniku dokumentov.

• Ko vas naprava pozove, preuredite 
dokumente kot začetek posla in 
jih znova naložite v podajalnik 
dokumentov. Dokumenti bodo 
samodejno reciklirani, da se 
zagotovi integriteta posla.

Dvignite pokrov 
podajalnika 
dokumentov 

Dvignite pokrov 
podajalnega mehanizma

Spustite
ročaj za

odpravljanje
zagozdenj
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Pomoč
Ko uporabljate napravo, je vedno na voljo podrobna in pravočasna pomoč. Pomoč in 
nasveti so na voljo od različnih virov.

Na napravi
Gumb Help lahko pritisnete kadar koli, da 
odprete zaslone za pomoč. Sporočila, 
navodila na zaslonu in slike ponujajo 
dodatne informacije. 

Dokumentacija
Odgovore na večino vprašanj najdete v 
dokumentaciji na CD-jih, ki ste jih dobili 
z napravo WorkCentre 4250/4260 Series. 
Dokumente si lahko ogledate tudi na 
spletnem mestu www.xerox.com/support.

• Uporabniški priročnik – vsebuje navodila in informacije o vseh 
funkcijah naprave.

• Vodnik za skrbnike sistema – podrobne informacije o priključevanju naprave 
v omrežje in nameščanju dodatnih funkcij.

V tiskalniškem gonilniku
Za informacije o prikazanem zaslonu 
tiskalniškega gonilnika kliknite Help ali pa 
na tipkovnici računalnika pritisnite [F1]. 
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V storitvah CentreWare 
Internet Services
Kliknite Index, da si ogledate 
vsebino mesta Internet Services.

Kliknite Help, da obiščete 
Xeroxovo spletno mesto 
za podporo.
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Zamik za greenwiški srednji čas
http://wwp.greenwichmeantime.com/.

Mesto/regija/
država

Zamik 
GMT

Mesto/regija/
država

Zamik 
GMT

Mesto/regija/
država

Zamik 
GMT

Mednarodna datumska 
črta – zahod

-12.0 Švica +1.0 Čenaj +5.5

Midway -11.0 Luksemburg +1.0 Kalkuta +5.5

Samoa -11.0 Avstrija +1.0 Mumbaj +5.5

Havaji -10.0 Hrvaška +1.0 New Delhi +5.5

Aljaska -9.0 Češka +1.0 Almati +6.0

Pacifiški čas
(ZDA, Kanada)

-8.0 Finska +1.0 Novosibirsk +6.0

Tijuana -8.0 Danska +1.0 Astana, +6.0

Gorski čas 
(ZDA, Kanada)

-7.0 Švedska +1.0 Daka +6.0

Srednja Amerika -6.0 Poljska +1.0 Šri Džajavarde-nenpura +6.0

Osrednji čas 
(ZDA, Kanada)

-6.0 Norveška +1.0 Rangun +6.5

Guadalajara -6.0 Italija +1.0 Bangkok +7.0

Bogota -5.0 Grčija +2.0 Hanoj +7.0

Lima -5.0 Turčija +2.0 Džakarta +7.0

Quito -5.0 Bolgarija +2.0 Krasnojarsk +7.0

Vzhodni čas 
(ZDA, Kanada)

-5.0 Egipt +2.0 Peking +8.0

Atlantski čas (Kanada) -4.0 Izrael +2.0 Čongčing +8.0

Caracas -4.0 Južna Afrika +2.0 Hongkong +8.0

La Paz -4.0 Jordanija +2.0 Urumči +8.0

Nova Fundlandija -3.0 Sirija +2.0 Irkutsk +8.0

Brazilija -3.0 Finska +2.0 Ulan Bator +8.0

Buenos Aires -3.0 Moskva +3.0 Kuala Lumpur +8.0

Grenlandija -3.0 Skt. Peterburg +3.0 Singapur +8.0

Azori -1.0 Volgograd +3.0 Tajpej +8.0

Zelenortski otoki -1.0 Kuvajt +3.0 Seul +9.0

Casablanca 0.0 Teheran +3.5 Jakutsk +9.0

Monrovia 0.0 Abu Dabi +4.0 Guam +10.0

VB 0.0 Muškat +4.0 Port Moresby +10.0

Irska 0.0 Baku +4.0 Vladivostok +10.0

Portugalska 0.0 Erevan +4.0 Magadan +11.0

Vzhodna Afrika 0.0 Tbilisi +4.0 Salomonovi otoki +11.0

Holandija +1.0 Kabul +4.5 Nova Kaledonija +11.0

Belgija +1.0 Jekaterinburg +5.0 Fidži +12.0

Francija +1.0 Islamabad +5.0 Kamčatka +12.0

Španija +1.0 Karači +5.0 Marshallovi otoki +12.0

Nemčija +1.0 Taškent +5.0 Nukualofa +13.0
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